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Notice 
The information in this document is subject to change without notice and shall not 
be construed as a commitment on the part of Connect One.  

Connect One assumes no liability for any errors that might appear in this 
document. 

The software described in this document is furnished under a license agreement 
and may be used or copied only in accordance with the terms of such a license 
agreement. It is forbidden by law to copy the software on any medium except as 
specifically allowed in the license agreement. No part of this document may be 
reproduced or transmitted in any form or by any means, electronic or mechanical, 
including but not limited to photocopying, recording, transmitting via fax and/or 
modem devices, scanning, and/or information storage and retrieval systems for 
any purpose without the express written consent of Connect One. 

iChip, iChip LAN, Socket iChip, Embedded iModem, Internet Controller, iLAN-100 
iLAN, iWiFi, iConnector, iConnectorLE, iModem, Nano WiReach, Nano LANReach, 
II-EVB, AT+i, Instant Internet and Connect One are trademarks of Connect One 
Ltd. 

Copyright © 2000-2012 Connect One Ltd. All rights reserved. 
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Preface 
Target Audience 
This document is intended for users of Connect One products who need to know 
how to configure the products' firmware and parameters with the iChipConfig 
Windows based GUI. 

Related Documents 
 AT+i Programmer’s Manual 
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1 Introduction 
 iChip Config Utility Overview 

 System Requirements 

 iChipConfig Utility Menus 

 iChip Config Utility Functionality 

1.1 iChip Config Utility Overview 
The iChip™ Config Utility, combined with any of Connect One’s products, enables 
quick and full configuration of the iChip, serial-based and web-based updating of 
firmware, and packaging of a website and parameters file. 

Connect One’s iChip Internet Controller™ is an Internet peripheral chip that 
offloads Internet connectivity tasks from a host processor. The host processor 
communicates with the iChip via Connect One’s high-level AT+i™ command set.  

The iChip Config utility enables you to configure and use the iChip without any 
need to know or use the AT+i commands – either for evaluation purposes or for 
updating your existing configuration. The AT+i commands are translated through 
the user-friendly GUI. All you need to do is define the parameters as described in 
each section of this manual. 

1.2 System Requirements 
To work with the iChip Config Utility, you need the following: 

 A PC with a free RS232 COM port 

 A device/board/module using the iChip you want to configure 

 An RS232 cable 

 Windows XP operating system 

1.3 Quick Tour of the iChip Config Utility 
1.3.1 iChipConfig Utility Menus 

The iChipConfig utility uses the following menus (Figure 1): 

 

Figure 1: iChipConfig Utility Main Menu Bar 

 File: Enables you to load an RPF file (a file including configuration parameters) or 
exit the program. 

 Tools: The Tools menu lists the same options as the icons displayed in the iChip 
Configuration Tools (Main) window, and more. 

 Wizards: Provides access to the Communication Platform Wizard and the 
SerialNET Configuration Wizard. 

 Host <-> iChip Options: Enables you to configure the connection mode between 
the host and iChip – either via COM port or socket. 
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 Serial Ports: Opens the Serial Settings window, where you can change the COM 
port on the PC and the PC’s COM port baud rate.  

 SerialNET: Enables you to enter and exit SerialNET mode. 

1.3.2 iChip Config Utility Functionality 
iChipConfig utility provides you with the following tools:  

 Quick Configuration  

 Full Configuration 

 Firmware Update 

 Web Parameters Update (iChip Uploader via Serial)  

 iChip Website Uploader via HTTP 

 Dumb Terminal 

 Send email attachment 

 Receive emails 

 Get URL 

 Change iChip communication platform  

 

Every iChip has its own set of features and parameters. You only have access 
to the features applicable to your product. For example, when configuring an 
iChip with only LAN support, parameters relating to dial-up and wireless 
modem are grayed out. 
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2 Getting Started 
 Installing iChipConfig Utility 

 Accessing iChipConfig Utility Tools 

2.1 Installing the iChipConfig Utility 
This procedure describes how to install the iChipConfig utility on your local 
workstation, so you can configure the iChip firmware or upload Web pages or 
parameter files. 

 What you need:  
 iChip Config installation ZIP file, downloaded from www.connectone.com. 

 How:  
1. Extract the contents of the ZIP file to a temporary folder in your local directory 

(for example, C:\Temp). 

2. Double-click setup.exe. 

3. The iChipConfig Setup window appears (Figure 2) 

 

Figure 2: iChipConfig Setup Window 

4. Click OK.  

The iChipConfig Setup window refreshes, displaying the default installation 
directory (Figure 3). 

http://www.connectone.com/
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Figure 3: iChipConfig Setup Window with Installation Directory 

 To change the installation directory: 

a. Click Change Directory.  
The Change Directory window appears. 

 

Figure 4: Change Directory Window 

b. In the Path field, type the destination directory in which to install the 
iChipConfig utility.  
- OR -  
In the Directories area, navigate to the destination directory. 

c. Click OK. 
The Change Directory window closes, and the iChipConfig Setup 
window refreshes, displaying the new installation directory. 

d. Click the Install  icon. 

The iChipConfig – Choose Program Group window appears. 
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Figure 5: iChipConfig - Choose Program Group Window 

e. Click Continue. 

The iChipConfig Setup window appears, displaying an installation 
progress bar. 

 

Figure 6: iChipConfig Setup Progress Bar 

When the progress bar reaches 100%, a dialog box appears, indicating 
successful installation. 

 

Figure 7: Successful iChipConfig Installation Message 

f. Click OK. 

The iChipConfig utility is now installed on your workstation. 
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2.2 Accessing iChipConfig Utility Tools 
This procedure describes how to open the iChipConfig Utility, set the correct baud 
rate, and use the utility to configure or send information to the iChip.  

 What you need:  
 Device or module using Connect One iChip or Connect One II-EVB board, 

connected to an RS232 COM port or USB port on your workstation, with power on. 

 How:  
1. From the Start menu, select Programs > ConnectOne > iChipConfig. 

The iChip Configuration Tools window appears. 

 

Figure 8: iChip Configuration Tools Window  

2. Click the icon of the tool you want to use. 

The first time iChipConfig is invoked, it attempts to locate the iChip connected to 
the PC’s COM port at the default baud rate of 9600. 

If the utility finds the chip, the tool window for the selected function appears. 
Continue with the relevant procedure for the tool (see Chapter 3, Working with 
iChipConfig). 

If the utility cannot find the iChip, the Serial Settings window appears. 
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Figure 9: Serial Settings Window 

3. From the Serial Port dropdown list, select the COM port on the PC to which the 
iChip is connected.  

4. From the Baud Rate dropdown list, select the baud rate used by the iChip. If 
you do not know the baud rate, select Scan. 

If Scan is selected, iChipConfig runs through the various baud rates until it finds 
the correct one. 

 

If the iChipConfig utility still fails to find iChip, make sure that an open 
application like Palm HotSync is not holding the port, or switch to a different 
COM port on the PC and scan again. After iChipConfig finds the baud rate, 
you can easily change the baud rate by clicking Serial Ports on the main page 
menu bar and selecting the desired baud rate. 

 

 



Connect One iChip Config Utility User Manual 

 

      Page 13 of 70 
 

3 Working with iChipConfig 
 iChipConfig Tools Overview 

 Quick Configuration 

 Full Configuration Tool 

 Working with the iChip Uploader (via Serial) Tool 

 Working with the Site Packer Tool 

 Working with the iChip Uploader (via HTTP) Tool 

 Working with the Dumb Terminal 

3.1 iChipConfig Tools Overview 
iChipConfig utility provides you with several tools that enable you to configure 
various parameters on your iChip. Depending on the iChip model you are 
connected to and the iChip firmware version you use, only the relevant parameters 
and sections are available. Others are grayed out, and cannot be configured. 

3.2 Quick Configuration 
3.2.1 Quick Configuration Tool Overview 

The Quick Configuration tool enables you to configure only the essential AT+i 
parameters required to send and retrieve an email. This is a good way to make 
sure that the iChip is operational on the LAN side, or that it is configured correctly 
to work with your ISP. 

Quick Configuration parameters, like all AT+i parameters, are stored in memory 
(either internal or external) and therefore need to be defined only once. 

3.2.2 Working with the Quick Configuration Tool 
This procedure describes how to use the Quick Configuration tool to configure only 
those AT+i parameters required to send and retrieve email.  

 

Additional mail configuration and manipulation parameters are available 

using the Full Configuration tool, as described in Section  3.3. 

 How:  
1. In the iChip Configuration Tools window, click the Quick Configuration  

icon. 

If you are using iChip or II-EVB, the <product> Quick Configuration window 
appears (Figure 10). 
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Figure 10: iChip Quick Configuration Window  

 

2. Do the following: 

 To configure iChip modem parameters: 

a. In the ISP Telephone Number field, type your ISP telephone number. 

 

Make sure you include any number required for access to an 
outside line. For example, if you must dial 9 to get an outside 
line, type 9,xxx-xxxx, where xxx-xxxx is your ISP number. If 
required, include the area code as well. 

b. In the Username field, type the username of the ISP account. 

c. In the Password field, type the password for the ISP account.  

d. Select the Blind Dial checkbox to instruct modem to dial out without 
waiting for a dialtone (for example, in a cellular modem environment) 

 To configure iChip LAN parameters: 

a. Determine whether you are working with a DHCP server, or in fixed IP 
address mode. 

b. To work in DHCP mode: 

Select the Use DHCP checkbox: 
Sets the values of the Default IP Address, Subnet, and 
Gateway fields to 0.0.0.0 and disables these fields for input. 

 To work in fixed IP address mode: 
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a. Make sure the Use DHCP checkbox is clear. 

b. In the Default IP Address field, type the IP address for the iChip. 

c. In the Subnet field, type the subnet address for your network.  

d. In the Gateway field, type your gateway address. 

e. Select the Use IP Finder checkbox to use the Connect One utility that 
finds iChip IP addresses on the network and activates the iChip Web 
server, enabling remote configuration of iChip through a browser. 

 

The MAC Address and Assigned IP Address fields are filled 
automatically, and cannot be modified. 

3. To configure iChip General parameters: 

 For sending email: 

a. In the SMTP Server field, type the name (string) or IP address of the 
SMTP server you use to send emails. 

b. In the Destination Email Address field, type the email address to which 
you want to send an email. 

c. In the Return Email Address field, type the email account to which 
replies should be sent. 

 For receiving email: 

a. In the POP3 Server field, type the name (string) or IP address of the 
POP3 server you use to receive emails. 

b. In the Mailbox field, type the email address at which you want to receive 
emails. 

c. In the Mailbox Password field, type the password for the email 
address, if one is required. 

4. Click Save. 

A dialog box appears, indicating the parameters are saved (Figure 11). 

 

Figure 11: Parameters Saved Successfully Dialog Box 

5. Click OK. 

The Quick Configuration window closes, and the iChip Configuration Tools 
window appears.  
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3.3 Full Configuration Tool 
3.3.1 Accessing the Full Configuration Tool 

This procedure describes how to access configuration tabs for all the possible 
iChip parameters, using the Full Configuration tool.  

 What you need:  
 Device or module using Connect One iChip or Connect One II-EVB board 

connected to your workstation, with power on 

 How:  
1. In the iChip Configuration Tools window, click the Full Configuration  

icon. 

The Configuration Tools window appears (Figure 12). 

 

Figure 12: Full Configuration Window 

2. The Configuration Tools window displays the tabs that enable you to 
configure various aspects of iChip functionality.  

3. Click the tab you want to configure.  

3.3.2 Configuring the Email Format Tab 
This procedure describes how to configure parameters for email format, properties, 
and sending and receiving emails.  
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 What you need:  
Access to Configuration Tools window, as described in Section  3.3.1. 

 How:  
1. In the Configuration Tools window, click the Email Format tab. 

The Email Format tab configuration fields are displayed (Figure 13). 

 

Figure 13: Email Format Tab of Full Configuration Tool 

2. To retrieve email headers together with the email body, select the Transmit 
Email Headers (XFH) checkbox. 

3. In the Limit Number of Headers (HDL) field, type the maximum number of 
header lines for the host to retrieve (leaving the field blank, or typing 0, 
configures the default value that enables retrieval of all sent headers). 

4. In the Filter String (FLS) field, type a string (word or phrase, ASCII format) by 
which to filter emails retrieved from the server. iChip only retrieves emails 
containing the defined string in the header lines. 

5. In the Subject (SBJ) field, type the word(s) you want to appear in the subject 
line of the email. 

6. In the Email Address (TOA) field, type the email address to which you want to 
send an email. 

7. To define a mailing list of up to 50 email addresses, click 50 Addressee. 

The 50 Addressee window appears (Figure 14). 
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Figure 14: 50 Addressee Window 

Type the email addresses in the Address column, and then click OK. 

The mailing list is saved.  

8. In the Address Description field, type the name of the person to whom you 
are sending an email. 

9. In the Return Email Address (REA) field, type the email address to which the 
email recipient should reply.  

10. In the Sender Description (FRM) field, type the name of the sender of the 
email. 

 

 

 

Example email scenario: 

If you want the iChip to send an email from the device to a 
person monitoring data collected by the device (say, Person1), 
you might type Person1’s email in the Email Address field 
(Person1@email.com), and then type Person1 in the Address 
Description field.  

If, in this scenario, you want replies to the email sent to you, 
you would type your email address in the Return Email Address 
field (you@email.com). 

In the Sender Description field, you might type the name of the 
device collecting the data. 

11. If you want to send copies of the emails sent from the iChip, in the Alternate 
Addressee fields (CC1-CC4), type the email addresses to CC. 

12. In the Message Body (BDY) field, type a message to appear in the body of the 
email. 

13. From the Media Type (MT) dropdown list, select the media type to use when 
sending an email (audio, video, application, or text). 
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14. In the Media Subtype String (MST) field, type the name of the media subtype 
of the email attachment. 

15. In the Attachment File Name (FN) field, type the attachment filename, 
including the extension. For example, filename.jpg. 

16. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save.  
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.3 Configuring the Server Profiles Tab 
This procedure describes how to configure parameters for incoming and outgoing 
mail servers and mailbox settings. 

 What you need:  
Access to the Configuration Tools window, as described in Section  3.3.1. 

 How:  
1. In the Configuration Tools window, click the Server Profiles tab. 

The Server Profiles tab configuration fields are displayed (Figure 15). 

 

Figure 15: Sever Profiles Tab of Full Configuration Tool 
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2. To keep a copy of retrieved emails on the server, select the Leave copy on 
server checkbox. If the checkbox is not selected, retrieved emails are deleted. 

3. In the Primary Domain Name Server (DNS1) and the Secondary Domain 
Name Server (DNS2) fields, type the IP addresses of the DNS servers you 
want to use to resolve logical server names into IP addresses (for working in 
LAN mode, with a fixed IP address). 

If you are working in DHCP mode, or using IP addresses and not logical names, 
leave these fields blank. 

 

On iChip Plus, DNS1, DNS2, SMTP and POP3 have two sets of parameters: 
one for the current communication platform and one for the inactive 
communication platform. In Figure 15 iChip Plus is configured to use the 
dialup communication platform, so the inactive communication platform 
should be defined with the LAN values for DNS1 and DNS2. 

4. In the Outgoing Mail Server (SMTP) field, type the name or IP address of the 
outgoing SMTP mail server.  

5. In the Incoming Mail Server (POP3) field, type the name or IP address of the 
incoming POP3 mail server.  

6. In the Mailbox User Name (MBX) and Mailbox Password (MPWD) fields, type 
the username and password you use to access the mailbox. 

7. If you specify an SMTP server that requires user authentication in the 
Outgoing Mail Server (SMTP) field, you need to select the SMTP 
Authentication (SMA) checkbox, and enter appropriate strings in the User 
Name (SMU) and Password (SMP) fields. 

8. In the DHCP Server Pool Size (DPSZ) field, enter an integer between 1 and 
255 to activate iChip’s internal DHCP server and set the number of IP 
addresses to be allocated in its IP pool. In addition, enter an integer between 0 
and 65535 to define the lease time, in minutes, to be granted by iChip’s DHCP 
server when assigning IP addresses to clients. A lease time value of ‘0’ means 
indefinite lease. 

9. In the Ping Polling Frequency (PFR) field, type a value defining the time 
interval (in seconds) at which iChip issues PING requests to one of the PING 
destination servers. 

10. In the Ping Destination 1 and Ping Destination 2 fields (PDS1 and PDS2), 
type the names or IP addresses of the primary and secondary PING destination 
servers. 

11. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save.  
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.4 Configuring the Operational Parameters Tab 
This procedure describes how to configure parameters for general operations. 

 What you need:  
Access to the Configuration Tools window, as described in Section  3.3.1. 



Connect One iChip Config Utility User Manual 

 

      Page 21 of 70 
 

 How:  
1. In the Configuration Tools window, click the Operational Parameters tab. 

The Operational Parameters tab configuration fields are displayed (Figure 16). 

 

Figure 16: Operational Parameters Tab of Full Configuration Tool 

2. (For use with modem operation only) from the Extended Return Code (XRC) 
dropdown list, select a value to determine the message/response mode – in 
particular, to activate or deactivate blind dial mode. (If you select 0 – Blind Dial 
from the dropdown list, make sure the Blind Dial checkbox is also selected). 

 

XRC is identical to ATXn and is applicable only for modem operation or II-
EVB in iModem mode. For more detailed information on the ATXn modes, 
refer to an AT Command Set reference source.  

3. In the Modem Initialization String (MIS) field, type the string that initializes the 
modem (refer to your modem’s user manual for more information). 

4. From the Modem Type Designator (MTYP) dropdown list, select the modem 
type to use with the iChip. 

 

Sets iChip to support a specific modem type. Analog modems, SiLabs 
Si2400 ISOmodem, GSM, GPRS, CDMA, TDMA, CDPD, iDEN and AMPS 
wireless modems are supported. 

5. Select the Suppress ATZ checkbox to prohibit iChip from issuing an ATZ 
command to the modem before dialing the ISP when an Internet session is 
activated (ATZ is a standard modem AT command, which resets the modem 
status. Suppressing ATZ might be useful if you need to manually initialize your 
modem). 

6. In the Wait Time Constant (WTC) field, type a value (in seconds) that the iChip 
waits for an answer, as defined in the modem S7 register.  
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7. In the TCP Timeout (TTO) field, type a value (in seconds) that defines the time 
iChip waits for an Internet transaction to complete before returning a timeout 
error. 

8. In the Inactivity Timeout (IATO) filed, type a value (in seconds) that defines 
how long iChip waits from the last activity before ending the session (SerialNET 
for iChip LAN, disconnecting the line for iChip Dial-Up). 

9. (For CDPD modems only): In the CDPD Password (CPWD) field, type the 
password for access to the modem. 

10. From the Max Packet Size (MPS) dropdown list, select the limit for outgoing 
PPP packets in a dialup environment. The MPS upper limit is the iChip 
maximum transmission unit (MTU). 

11. From the Host Interface (HIF) dropdown list, select the Interface over which 
the Host processor will send AT+i commands. (0 is Autodetect, meaning that 
iChip will determine the Host interface as the interface where the first AT+I 
command is received). 

12. From the Bridge Mode (BRM) dropdown list, select the required LAN-to-WiFi 
Bridge mode. Specify 0 when this mode is disabled. 

13. From the Baud Rate (BDRM) dropdown list, select a value to set the baud rate 
at which the iChip communicates with the modem.  

14. From the Fixed Baud Rate (BDRF) dropdown list, select a value to set the 
baud rate at which the modem communicates with the host. 

15. From the Flow Control (FLW) dropdown list, select a flow control value (No 
Flow Control, iChip to Host Hardware Flow Control, iChip to Modem 
Hardware Flow Control, or iChip to Modem and Host Hardware Flow 
Control). 

16. Select the Disable Reflection checkbox to disable reflection of hardware flow 
control signals (CTS, RTS, DTR, and DSR signal are mirrored across the 
iChip/iChip plus by default). 

17. From the Dial Mode (DMD) dropdown list, select either Pulse or Tone dialing. 

18. From the Activate Web Server (AWS) dropdown list, select a value to set 
automatic iChip Web server activation. Choose from the following: 

 Disabled: Default value. Disables automatic Web server invocation. 

 Enable Backlog n: Web server is automatically activated when iChip 
goes online in SerialNET mode, or as a result of a triggered Internet 
session. n = the maximum number of concurrent browser connections. 

19. From the Triggered Up (TUP) dropdown list, select a value for Internet session 
initiation mode (mostly applicable for work with a modem). Select from the 
following:  

 Disabled: Disables iChip from initiating a triggered Internet session. 

 Enabled: Sets iChip to initiate Internet sessions in response to a defined 
trigger (such as a RING signal detected on a modem). 

 Always Online: Sets iChip to remain online continually, without any 
trigger to initiate the session. 

20. From the Modem Interface (MIF) dropdown list, select the Interface over which 
the iChip will connect to a dialup or cellular modem. 
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21. In the A2D detect threshold (ADCL) field specify the A/D level [0..255], which 
is the center of the A/D hysteresis window.   

22. In the A2D detect period interval (ADCT) field specify the time interval in 
milliseconds between A/D quieries. 

23. In the A2D detect threshold delta (ADCD) field specify the A/D hysteresis 
window size, defined as ADCL+/-[ADCD]. 

24. In the A2D detect GPIO pin field specify the pin that will be toggled when the 
A/D level crosses the hysteresis window. Specify 0 to disable signaling. A value 
of [1..6] corresponds to pins PIOC[0..5]. The signal will be set HIGH when when 
crossing over to ADCL+ADCD and set LOW when crossing below ADCL-ADCD. 

25. In the SPI Control Signal (SPIP) field specify the pin number that iChip will use 
to control the SPI flow direction. Specify 0 to disable. A value of [1..6] 
corresponds to pins PIOC[0..5]. 

26. In the MAC Filter (MACF) field, specify a MAC address to enforce filtering out 
of any packets that are not from this MAC address in LAN-to-WiFi Bridge 
modes BRM=1 or 3. Leave this field empty to disable MAC filtering. 

27. Select the Network Time-of-Day (NTOD) checkbox to enable iChip to set the 
time according to a network time-of-day server. 

28. In the Network Time Server fields (NTS1 and NTS2), type the name or IP 
address of the primary and secondary (optional) network time server. 

29. In the Greenwich Mean Time Offset (GMTO) field, type the difference in time 
(in hours) between the iChip location and GMT. For example, if the iChip 
location is one hour ahead of GMT, type 1. If the iChip location is one hour 
behind GMT, type -1. 

30. In the Daylight Saving Time Definition (DSTD) field, enter a Daylight Savings 
Time transition rule. This rule must contain start and end dates for DST. 

31. Select the IP Prot. Don’t Fragment Bit (DF) checkbox to disable bit 
fragmenting in outgoing IP packets. 

32. To enable sending remote AT+i commands to the iChip, in the AT+i Socket 
Server (LATI) field, type the name/number of the listening COM port. When the 
iChip is connected to the Internet, it opens a TCP/IP listen socket on the local 
IP address and specified port that can receive remote AT+i commands. 

33. In the Host Name (HSTN) field, type the iChip network host name, or a unique 
identifying name for a LAN or dialup environment. 

34. In the Baud Rate Divider (BDRD) field specify a value of [1..255]. This will be 
used to define the Host interface baud rate as [3M / BDRD], when one of the 
COM ports is used as the Host interface. 

35. From the Framing Mode (FMOD) dropdown list, select the Framing Disabled (0) 
or Enabled (1).  

36. From the PPP ACFC negotiation (PPP) dropdown list, select the ACFC 
negotiation mode appropriate for the PPP protocol being used. 

37. Select the Auto Router Start (ARS) checkbox, to specify that iChip should 
automatically Power-up into iRouter mode. This flag should not be specified 
when the BRM parameter specifies Bridge mode. 

38. Select the Calculate Checksum (CKSM) checkbox to instruct iChip to 
calculate the checksum of Send and Receive (Write and Read) commands. If a 
checksum error is encountered, the data is retransmitted. 
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39. In the Timeout to Resend PING Request (PGT) field, type a value (in 
seconds) to set the time interval after which iChip reissues an unanswered 
PING request. 

40. In the Timeout to Resend Unacked TCP Packet (TTR) field, type a value (in 
seconds) to set the time interval after which iChip retransmits an 
unacknowledged TCP packet over PPP connection. 

41. From the Select Pin 44 Function (PN44) dropdown list, select one of the 
following: 

 Clock Out: To set Pin 44 to provide a clock signal at the same frequency 
as iChip’s clock input signal (X1 – Pin 42). 

 Heartbeat: iChip outputs a square wave (frequency ~80mSec with a 50% 
duty cycle). 

42. From the Watchdog Activation Mode (WDM) dropdown list, select either 
Disabled (default) or Enabled (activates FW monitoring – if a problem is 
encountered, a hard reset takes place). 

43. In the Readiness Report HW (RRHW) field, specify which of iChip’s general-
purpose I/O pins (GPIO) will be asserted Low to indicate iChip readiness to the 
host. Specify 0 to disable. A value of [1..6] corresponds to pins PIOC[0..5]. 

44. In the Content Type (CTT) field, specify the content of the “Content-type:” field 
that is sent in the POST request. This field specifies the type of the data/file 
being sent. When left empty a default value of “application/x-www-form-
urlencoded” will be used, and the server will expect the data to be the data sent 
in a “Submit” of a form. 

45. From the LAN Type (LTYP) dropdown list, select the prefered LAN when the 
iChip is connected both to an Ethernet and WiFi LAN. When set to its default 
(0), iChip shall automatically detect the LAN platform and if both exist, iChip will 
prefer the WiFi.  

46. In the Web site Logo (LOGO) field, specify the filename of a *.GIF file the 
contains an alternate Logo image to be displayed in iChip’s Configuration site. 
The default value specifies Connect One’s Logo image.  

47. Select the Set Power Save Mode (PSE) checkbox to enable the power save 
mode, in which iChip automatically shuts down most of its circuits after a period 
of n seconds without any activity on the host or modem serial ports. Renewed 
activity on the serial ports restores iChip to full operational mode. 

48. In the Service Disable Mask (SDM) area: 

 Select the PING Reply checkbox to prohibit iChip from responding to 
PING requests (this can protect against PING attacks). 

 Select Remote Debug checkbox to disable the remote debugging feature. 

 Select the Unauth. Web Server checkbox to prohibit unauthenticated 
viewing of the iChip internal website. 

 Select Disable SNET Escape with ‘+++’ to prohibit exiting SerialNET 
mode when the ‘+++’ Escape sequence is detected. 

 Select Disable Break Reset to support use of the Break signal for exiting 
SerialNET. Deselect this flag to use Break to reset iChip and reboot into 
SerialNET mode. 

 Select Disable Internal Config Site to prohibit browsing to iChip’s 
internal Configuration Web site. 
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49. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.5 Configuring the LAN Tab 
This procedure describes how to configure parameters for working in a LAN 
environment. 

 What you need:  
Access to the Configuration Tools window, as described in Section  3.3.1. 

 How:  
1. In the Configuration Tools window, click the LAN tab. 

The LAN tab configuration fields are displayed (Figure 17). 

 

Figure 17: LAN Tab of Full Configuration Tool 

2. Determine whether you are working with a DHCP server, or in fixed IP address 
mode. 

a. To work in DHCP mode: 

Select the Use DHCP checkbox. 
Set the values of the Default IP Address, Subnet, and Gateway 

fields to 0. 
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b. To work in fixed IP address mode: 

In the Default IP Address field, type the IP address for the iChip. 
In the Subnet field, type the subnet address for your network.  
In the Gateway field, type your gateway address. 
Make sure the Use DHCP checkbox is clear. 

 

The MAC Address and Assigned IP Address fields are filled 
automatically, and cannot be modified. 

3. Select the Use IP Finder checkbox to use the Connect One utility that finds 
iChip IP addresses on the network, and activates the iChip Web server, 
enabling remote configuration of iChip through a browser. 

4. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.6 Configuring the Remote FW Tab 
This procedure describes how to configure parameters for remote firmware (FW) 
updates. Remote FW updates can be performed via FTP or HTTP. Update files are 
saved on a server, whose location is defined in the Remote FW tab. 

 What you need:  
Access to the Configuration Tools window, as described in Section  3.3.1. 

 How:  
1. In the Configuration Tools window, click the Remote FW tab. 

The Remote FW tab configuration fields are displayed (Figure 18). 
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Figure 19: Remote FW Tab of Full Configuration Tool 

2. Select the Enable Fallback Update checkbox to enable an update to an older 
version of the iChip firmware. 

3. In the Firmware Update Server (USRV) field, type the name and directory of 
the update file location. 

4. If the file is in an FTP directory, type the username and password in the UUSR 
and UPWD fields. 

5. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.7 Configuring the ISP Connection Tab 
This procedure describes how to configure parameters for working in a dialup 
environment. 

 What you need:  
Access to the Configuration Tools window, as described in Section  3.3.1. 

 How:  
1. In the Configuration Tools window, click the ISP Connection tab. 

The ISP Connection tab configuration fields are displayed (Figure 20). 
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Figure 20: ISP Connection Tab of Full Configuration Tool 

2. In the First Phone Number and Second Phone Number fields (ISP1 and ISP2), 
type the main and alternate phone numbers you use to connect to your ISP.  

Include any required area codes, and outside line access numbers. Use a comma 
to create a dialing delay. For example, if you need to dial a 9 for an outside line, 
type 9,nnnnnnn, where n = digits of the dialed phone number. 

3. In the User Name (USRN) field, type your username as defined by your ISP. 

4. In the Password (PWD) field, type your password as defined by your ISP. 

5. From the Authentication Method (ATH) dropdown list, select the 
authentication method supported by your ISP (Script, PAP, or CHAP). 

6. In the Max Redial Trials (RDL) field, type the number of redial attempts for 
each ISPn. 

7. In the Wait Time Before Redial (RTO) field, type the value (in seconds) of the 
time interval between redial attempts. 

8. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 
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3.3.8 Configuring the Remote Params Update Tab 
This procedure describes how to set a password for remote parameter updating. 
The remote update password (RPG) functions as follows: 

 If an RPG is not set (field is blank), remote firmware updates are disallowed, and 
Web parameters cannot be set via a Web browser. 

 If the RPG is set to *, iChip allows remote updating without password 
authentication. 

 If the RPG is defined to any other value, the user must submit that exact value to 
perform remote updates. 

 What you need:  
Access to the Configuration Tools window, as described in  3.3.1. 

 How:  
1. In the Configuration Tools window, click Remote Params Update tab. 

The Remote Params Update tab configuration fields are displayed (Figure 21). 

 

Figure 21: Remote Params Tab of Full Configuration Tool 

2. In the Remote Update Password (RPG) field, type the desired password, or 
ensure the field is clear if you do not want a password defined. 

3. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 
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 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.9 Configuring the HTTP Tab 
This procedure describes how to configure parameters for Web updates. 

 What you need:  
Access to the Configuration Tools window, as described in  3.3.1. 

 How:  
1. In the Configuration Tools window, click HTTP tab. 

The HTTP tab configuration fields are displayed (Figure 22). 

 

Figure 22: HTTP Tab of Full Configuration Tool 

2. In the URL to Retrieve (URL) field, type the URL of the HTTP page or item 
(such as a picture) for iChip to retrieve. 

3. In the Web Password (WPWD) field, type a password as follows: 

 If a password is not set (field is blank), Web parameters cannot be set via 
a Web browser. 

 If the password is set to *, iChip allows Web updating without password 
authentication. 

 If the password is defined to any other value, the user must submit that 
exact value to perform Web updates. 
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4. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.10 Configuring the SerialNET Tab 
This procedure describes how to configure parameters for iChip to work in 
SerialNET mode. 

 What you need:  
Access to the Configuration Tools window, as described in  3.3.1. 

 How:  
1. In the Configuration Tools window, click the SerialNET tab. 

The SerialNET tab configuration fields are displayed (Figure 23). 

 

Figure 23: SerialNET Tab of Full Configuration Tool 

2. In the Character to Enforce Flush (FCHR) field, type the value you want to 
use to generate a TCP packet flush. 

3. In the Max Characters before Flush (MCBF) field, type the number (integer) 
of characters for iChip to buffer before a TCP packet is flushed. 

4. In the Max Timeout to Flush (MTTF) field, type the value (in seconds) of the 
time interval for iChip to wait before flushing a TCP packet. 
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5. In the Disconnection String (DSTR) field, type the string to trigger iChip to 
complete the SerialNET session (iChip closes the socket, but remains in 
SerialNET mode. iChip also goes offline in Dial-Up operation). 

6. Select the Send DSTR checkbox to Send the DSTR string from iChip to the 
socket. 

7. In the Timeout Before Reestablishing Connection (SNRD) field, type the 
value (in seconds) of the time interval for iChip to wait before attempting to 
reestablish a lost socket connection. 

8. In the Port Settings for SerialNET (SNSI) field, type the values for the baud 
rate, number of data bits, parity, and stop bit for iChip in SerialNET mode. Use 
the format <baud>,<data_bits>,<parity>,<stop_bits>,<flow>.  

9. In the Max Bytes to Buffer (MBTB) field, type the value of the maximum 
number of bytes for iChip to buffer while waiting to establish an Internet 
connection.  

10. From the Socket Type (STYP) dropdown list, select either UDP or TCP as the 
destination socket type. 

11. In the Server SerialNET Port (LRPT) field, type the number of the listening 
port for the SerialNET server. 

12. In the IP Address to Connect to (HSRV) field, type the port server name or IP 
address for iChip to locate and connect to when serial data is transmitted from 
the device. 

13. In the Alternate IP Address to Connect to fields (HSR1 and HSR2), type 
alternate port server names or IP addresses for iChip to connect to if HSRV is 
nonresponsive.  

14. In the Serial Phone Number (SPN) field, type the phone number to use to 
wake up a remote SerialNET server.  

15. In the SerialNET Dialup Timeout (SDT) field, type the value (in seconds) of 
the time interval to elapse for iChip to cease attempting to wake up a remote 
SerialNET server (via dialup). 

16. In the Packets to Drop (PTD) field, type the filtration ratio factor value to 
determine how many of the packets iChip generates are sent to the host. For 
example, if the value is set to 0, every packet iChip generates is sent to the 
host. If the value is set to 2, two packets are ignored, and then the next packet 
is sent, and so on. 

17. In the SerialNET Wakeup Timeout (SWT) field, type the value (in seconds) of 
the time interval to elapse for iChip to cease attempting to wake up a remote 
SerialNET server. 

18. In the HSS field, enter a string containing three control characters that 
determine switching among the three possible remote servers HSRn. 

19. In the SerialNET Indicator Signal (SLED) field, specify the GPIO to use to drive 
a LED indicator when iChip is in SerialNET. Specify 0 to disable. A value of 
[1..6] corresponds to pins PIOC[0..5]. The specified GPIO shall be driven LOW 
when iChip is in SerialNET mode. 

20. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 
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 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.11 Configuring the IP Registration Tab 
This procedure describes how to configure IP Registration parameters, which 
enable iChip to broadcast online status and information. 

 What you need:  
Access to the Configuration Tools window, as described in  3.3.1. 

 How:  
1. In the Configuration Tools window, click the IP Registration tab. 

The IP Registration tab configuration fields are displayed (Figure 24). 

 

Figure 24: IP Registration Tab of Full Configuration Tool 

2. In the Server Address to Register (RRSV) field, type the name or IP address 
of the ring response server, and port number with which iChip establishes a 
connection in response to a RING detected on the modem.  

The IP address dynamically assigned to iChip by the ISP and the LPRT listening 
port are sent to the server, and then the socket is closed.  

3. In the Email Address to Send IP (RRMA) field, type the email address of the 
recipient of notification email messages sent after iChip establishes a 
connection to the ISP in response to a RING detected by the modem.  
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The email notification message includes the IP address dynamically assigned to 
iChip by the ISP, and the LPRT listening port. 

4. In the Ring Response Web Server URL (RRWS) field, type the URL of the ring 
response Web server to use for dynamic registration. 

5. In the Ring Response Return Link (RRRL) field, type the IP address of the 
ring response return link and the Web port. 

6. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.12 Configuring the User Fields Tab 
This procedure describes how to configure user fields, which can be used for the 
following purposes: 

 General storage: You can type any string in each of the fields in order to save a 
list. 

 Macro replacement 

 What you need:  
Access to the Configuration Tools window, as described in  3.3.1. 

 How:  
1. In the Configuration Tools window, click the User Fields tab. 

The User Fields tab configuration fields are displayed (Figure 25). 



Connect One iChip Config Utility User Manual 

 

      Page 35 of 70 
 

 

Figure 25: User Fields Tab of Full Configuration Tool 

2. In each User Field (UFn) field, type the desired value.  

3. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.13 Configuring the RAS Tab 
This procedure describes how to configure remote access server (RAS) fields, 
which enable you to dial into the iChip. 

 What you need:  
Access to the Configuration Tools window, as described in  3.3.1. 

 How:  
1. In the Configuration Tools window, click the RAS tab. 

The RAS tab configuration fields are displayed (Figure 26). 
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Figure 26: RAS Tab of the Full Configuration Tool 

2. In the RAS Username (RAU) field, type the username used to access the RAS.  

3. In the RAS Password (RAP) field, type the password used to access the RAS. 

4. In the RAS Rings (RAR) filed, type the number of rings after which the RAS 
allows the connection. 

5. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.14 Configuring the Wireless LAN Tab 
This procedure describes how to configure wireless LAN communication 
parameters. 

 What you need:  
Access to the Configuration Tools window, as described in  3.3.1. 

 How:  
1. In the Configuration Tools window, click the Wireless LAN tab. 

The Wireless LAN tab configuration fields are displayed (Figure 27). 



Connect One iChip Config Utility User Manual 

 

      Page 37 of 70 
 

 

Figure 27: Wireless LAN Tab of Full Configuration Tool 

2. In the General WLAN Parameters group: 

a. From the Wireless LAN Channel (WLCH) dropdown list, select the 
iChip communications channel to be used when creating an Ad-Hoc 
network. 

b. From the Security Type (WSEC) dropdown list, select the default WPA 
or WPA2 security to use. 

c. In the Power Save (WLPS) field, specify the number of beacon periods 
during which the WiFi chipset remains in Power Save mode before 
scanning for the next Beacon. Define a 0 value to disable WiFi Power 
Save mode.  

d. From the Roaming Mode dropdown list, Disable or Enable Wireless 
LAN Roaming. Roaming mode is used to transfer between AP’s without 
obstructing an ongoing connection. 

e. In the WLAN Lo SNR TH (WSLR) field specify the threshold value (in 
percent) below which iChip will start searching for a new AP to roam to. 

f. In the WLAN Hi SNR TH (WSLH) field specify the threshold value (in 
percent) above which iChip will roam to a new AP. 

g. In the Periodic Scan Interval (WPSI) field specify the time interval in 
seconds, between consecutive scans that iChip will perform in search 
for APs in its vicinity. 

h. In the Access Point BSSID (BSID) field specify the BSSID of the 
specific AP to connect to. AP BSSID is the AP MAC address. 
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i. In the Enterprise Domain/User (EUSN) field specify the Domain and 
User name to use when connecting to a WLAN in Enterprise mode via  
RADIUS server. 

j. In the Enterprise Password (EPSW) field specify the Password to use 
when connecting to a WLAN in Enterprise mode. 

3. In the WLAN SSID group: 

a. In the Wireless LAN SSID (WLSI) field, type the value (string) of the 
major AP system-set ID (SSID). When specifying an Ad-Hoc system, 
prefix the SSID string with an ‘!’ mark. 

b. In the SSIDi (WSIi) fields specify additional (fall-back) SSID strings. If a 
connection to the AP according to WLSI is not successful, iChip will 
scan through the SSID list until a successful connection is made. 

4. In the WEP Parameters group: 

a. From the Wireless LAN WEP Mode (WLWM) dropdown list, select the 
wired equivalent privacy (WEP) mode to work with in the wireless LAN 
environment.  

b. From the Wireless LAN Key Index (WLKI) dropdown list, select the 
WEP key index value to use to transmit WiFi packets. 

c. In the Wireless LAN Key (WLKn) fields (1-4), type a key value 
(hexadecimal string) to define the WEP key array in a WEP-secured 
wireless LAN environment (as defined in the WLWM parameter, step 4). 
The WEP key array is used to encrypt outgoing packets using the key 
defined in the WLKI parameter, step 5), and decrypt incoming packets. 

The identical value must be configured in the same position in the AP router. 

5. In the WLAN Security Type group: 

a. From the Security type i (WSTi) dropdown list select the type of security 
required for each AP whose SSID is specified in the corresponding WSIi 
field. 

6. In the WLAN WPA Pass Phrase group: 

a. In the WPA-PSK Pass Phrase (WLPP) field, enter an ASCII string 
containig 8-63 characters to be used in generating a WPA-PSK 
encryption key. 

b. In the WPA-PSK Pass Phrase i (WPPi) field, enter an ASCII string 
containing 8-63 characters to be used in generating a WPA-PSK 
encryption key for the AP whose SSID is specified in the corresponding 
WSIi field. 

7. In the WEP Multi SSID Keys group: 

a. In the WEP Key i (WKYi) field, specify the WEP key to use to connect to 
a WEP secured AP whose SSID is specified in the corresponding WSIi 
field.  

8. Do one of the following:  

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 
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 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.15 Configuring the SSL Tab 
This procedure describes how to configure user fields related to Secure Socket 
Layer (SSL) encryption. 

 What you need:  
 3.3.1 Access to the Configuration Tools window, as described in . 

 Knowledge/proficiency in SSL encryption and certification. 

 How:  
1. In the Configuration Tools window, click the SSL tab. 

The SSL tab configuration fields are displayed (Figure 26). 

 

Figure 26: SSL Tab of Full Configuration Tool 

2. From the Cipher Suite (CS) dropdown list, select the cipher suite to be used in 
SSL3/TLS1 negotiations with a secure server. 

3. In the Trusted Certificate Authority (CA) fields (1-4), you can load up to 4 
different certificates obtained from trusted certificate authorities. iChip 
establishes an SSL3/TLS1 socket connection only to servers having a 
certificate authenticated by these authorities. Use the Load Certificate button 
to load a certificate, and the Clear Certificate button to remove it from the field. 
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4. In the Private Key (PKEY) field, you can load iChip’s private key. The private 
key is required to perform an RSA encryption of its certificate (see CERT 
parameter, below) when performing client side authentication. 

5. In the iChip Certificate (CERT) field, you can load iChip’s SSL3/TLS1 
certificate. Some SSL3/TLS1 servers require the client side to authenticate its 
identity by requesting the client to provide a certificate during the SSL socket 
negotiation phase. This is called ‘client side authentication.’ If the CERT 
parameter contains a certificate, iChip provides it to the server upon request. 
iChip also needs a private key (see PKEY parameter, above) in order to encrypt 
its certificate before sending it to the server. In addition, the certificate must be 
signed by a certificate authority accepted by the server for the client side 
authentication to succeed. 

6. Fill in fields as required, and then do one of the following: 

 To apply the defined parameters and continue working in the 
Configuration Tools window, click Apply. 

 To save the defined parameters and exit the Configuration Tools 
window, click Save. 
Your definitions are saved, the Configuration Tools window closes, and 
the iChip Configuration Tools window appears. 

3.3.16 Using the Full Configuration Menu 
• File Menu 

Use the File Menu to save all iChip parameters to an RPF file. When 
selecting this option the following dialog will be displayed: 

 
Select Start from factory defaults to save all parameters with value 
different from the factory defaults. 

Check and define a GROUP password to restrict RPF update to iChips 
that have their RPG field set to the same GROUP password. 

Check and define Destination Chip Serial Number to restrict RPF 
update only to a specific iChip with this serial number. 

• Search for Parameter 

Use this menu option to search for a parameter. The following dialog is 
displayed: 

 
Type in the parameter name and click OK. 
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3.4 Working with the iChip Uploader (via Serial) Tool 
This procedure describes how to upload iChip’s firmware and perform other 
operations via the serial host interface using the Uploader tool.  

 What you need:  
 Device or module using Connect One iChip or Connect One II-EVB board 

connected to your workstation, with power on 

 How:  
1. In the iChip Configuration Tools window, click the iChip Uploader  icon. 

2. Perform the desired upload actions to your iChip (step 1). 

3. To exit the iChip Uploader tool, click either Close or Exit. 

3.4.1 Updating Firmware for CO2128SEC Locally 
The II-EVB-630W can be updated locally via the Tools > CO2128/2064 Monitor 
Mode command, or via the iChip Uploader feature of the iChipConfig Utility. First-
time installation of the firmware must be done via Monitor Mode. Successive 
firmware updates can be performed using the iChip Uploader, which is a much 
faster procedure that does not require re-installation of the boot loader. 

First-Time Firmware Installation Using Monitor Mode 
1. Open the iChipConfig utility. 

 
2. Click Tools > CO2128/2064 Monitor Mode. 
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3. In the dialog box displayed, select EBI Flash 16 Megabit for (2Mbyte Flash) 
option and click OK. 

 
4. Recycle power to the II-EVB-630W while holding down the Mode Select (MSEL) 
switch for at least 5 seconds, and click OK to continue. 

 
5. The following window appears while the FPRO application is installed. 

 
6. The Monitor Mode dialog box is displayed. Click the FW Update button. 

 
7. In the dialog box that appears, browse to the location of the Boot Block IMF file 
you obtained from Connect One, select the file and click Open. 
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8. Click Yes when prompted. 

 
9. The following window appears while certain sectors of the flash are being erased 
and the boot block is being installed. 

 
10. OK the dialog box that appears when the boot block has been installed 
successfully. 

 
11. In the Monitor Mode dialog box, click the FW Update button again. 
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12. In the dialog box that appears, browse to the location of the firmware IMF file 
you obtained from Connect One, select the file and click Open. 

 
13. Click Yes when prompted. 

 
14. The following window appears while the firmware is being installed on the flash. 

 
15. OK the dialog box that appears when installation has completed successfully. 

 
16. Click the Exit Monitor Mode button on the Monitor Mode window to return to 
command mode. 

Updating Existing Firmware Using the iChip Uploader 
Note:  This procedure assumes that the SPI flash memory on the  
II-EVB-630W already contains a previous version of the iChip firmware. 

1. Open the iChipConfig utility. 
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2. Click the iChip Uploader via Serial icon. 

3. In the dialog box displayed, select the EBI Flash 16 Megabit for (2Mbyte Flash) 
option and click OK. 

 
4. The Monitor Mode dialog box is displayed. Click the FW Update button. 
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5. In the dialog box that appears, browse to the location of the firmware IMF file 
you obtained from Connect One, select the file and click Open. 

 
6. Click Yes when prompted. 

 
7. The following window appears while the firmware is being installed on the flash. 

 
8. OK the dialog box that appears when installation has completed successfully. 

 
9. Click the Exit Monitor Mode button on the Monitor Mode window to return to 
command mode. 
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 To view iChip memory information on your monitor: 

a. Click Memory Dump.  
The Memory Dump window appears (Figure Error! Bookmark not 
defined.).  

 

Figure 28: Memory Dump Window 

b. Type values in the fields, then click OK. 

 To dump the iChip memory to a file: 

a. Click Dump Memory to File.  
The Dump Memory to File window appears (Figure Error! Bookmark 
not defined.).  

 

Figure 29: Dump Memory to File Window 

b. In the File to Use field, type the path and filename of the file to which 
you want to dump the iChip memory. 
- OR -  
Click … to browse and select a file. 

c. Type values in the fields, then click OK.  
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3.5 Working with the Site Packer Tool 
This procedure describes how to pack a website and upload it to iChip 

 

Version 7.0x and onward support website serving, as opposed to single 
webpage serving supported by earlier versions. 

 What you need:  
 Device or module using Connect One iChip or Connect One II-EVB board 

connected to your workstation, with power on 

 How:  
1. In the iChip Configuration Tools window, click the Site Pack  icon. 

The Website Packer window appears (Figure 30). 

 

Figure 30: Website Packer Window 

1. From the Platform dropdown list, select the iChip platform you are working with. 

2. In the Select Directory area, locate the website root directory. 

3. Select a file as the default Home Page of the site. By default, the Packing tool will 
select index.htm/index.html as the default home page, if such a file exists in the 
root directory  
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4. Click Pack. 
The Website Packer window refreshes, displaying the website parameters in the 
Max Parameter Value area (Figure 31).  

 

Figure 31: Website Parameters 

5. Do one of the following: 

 In the Param Max Size column, type the value for each parameter. 

 Select the parameters to be filled and in the Fill Selected Parameters 
with Value field, type a value, and then click Fill. 
All selected parameters are updated with the defined value. 

6. Click Save. Define or select a filename. The default file extension is set to IMG. 

7. Click Close.  

 

Also, you can choose the Load file button to submit a file that holds 
individual parameter size per parameter. Only parameters that appear in the 
web site being packed will be affected. The file in a *.TXT file and the format 
is Parameter=SizeCR/LF.  

Any line that starts with \\ will be regarded as remark and ignored. 

3.6 Working with the iChip Uploader (via HTTP) 
Tool 
This procedure describes how to perform an update on the iChip from a webpage 
loaded on the iChip or load a website on the iChip.  

 What you need:  
 Device or module using Connect One iChip or Connect One II-EVB board 

connected to your workstation, with power on 

 Website loaded on iChip, with an update option available. 

 How:  
8. In the iChip Configuration Tools window, click the iChip Uploader (via 

HTTP)  icon. 

The Web Uploader window appears (Figure 32). 
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Figure 33: Web Uploader Window 

9. In the iChip IP Address field, type the IP address of your iChip. 

 To get the iChip’s IP address: 

a. Close the Web Uploader window.  

b. In the iChip Configuration Tools window, click the Dumb Terminal 

 icon. 
The Dumb Terminal window opens. 

c. In the Dumb Terminal window, type AT+iipa?, and press Enter. 
The iChip IP address is displayed. 

 Enable iChip’s web server: 

a. In the Dumb Terminal window, type AT+iAWS=3, and press Enter. 
10. Click Go.  

The iChip webpage is displayed (Figure 34), and you can perform your firmware 
update. 
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Figure 35: Website Uploader Window, Displaying the Webpage for the Update 

3.7 Working with the Dumb Terminal 
This procedure describes how to work with the dumb terminal of the iChipConfig 
utility. The dumb terminal enables you to input AT or AT+I commands, and to 
review the iChip or modem response. You can also configure your port and baud 
rate in the Dumb Terminal,  

 What you need:  
 Device or module using Connect One iChip or Connect One II-EVB board 

connected to your workstation, with power on 

 How:  
1. In the iChip Configuration Tools window, click the Dumb Terminal  icon. 

The Dumb Terminal window appears (Figure 36). 
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Figure 36: Dumb Terminal Window 

2. To select a COM port and baud rate, click Setup Port. 
The Serial Settings window appears (Figure 37), enabling you to select a port, 
and baud rate. 

 

Figure 37: Serial Settings Window 

3. To change the baud rate you are working with, click Change iChip Baud Rate. 

The Serial Settings window appears (Figure 37), enabling you to select a port), 
and baud rate. 
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4 Wizards 
 Wizards Overview 

 Communication Platform Wizard 

 SerialNET Configuration Wizard 

4.1 Wizards Overview 
The iChipConfig utility includes two wizard that take you through the configuration 
process: 

 Communication Platform Wizard: Takes you through configuration of 
parameters for the communication platform. 

 SerialNET Configuration Wizard: Takes you through configuration of SerialNET 
mode details. 

4.2 Communication Platform Wizard 
4.2.1 Starting the Communication Platform Wizard 

This procedure describes how to access the Communication Platform Wizard, and 
begin to define iChip parameters.  

 How:  
1. From the iChipConfig main menu bar, select Wizards > Communication 

Platform.  

The Communication Platform Wizard window appears (Figure 38). 

 

Figure 38: Communication Platform Wizard Window 

2. From the Communication Platform dropdown list, select the communication 
platform you are using (Dialup, GSM, GPRS, or LAN), and then click Next. 



Connect One iChip Config Utility User Manual 

 

      Page 54 of 70 
 

The window for the selected communication platform opens, enabling you to 
configure applicable parameters. 

Related Topics: 
 

4.2.2 Configuring Dialup or GSM Parameters 
This procedure describes how to configure dialup communication platform 
parameters, using the Communication Platform Wizard. 

 What you need:  
 Completion of Starting the Communication Platform Wizard, with the Dialup 

parameter selected. 

 How:  
1. After you click Next in the first Communication Platform Wizard window, the ISP 

Account Parameters area for dialup/GSM appears (Figure 39). 

 

Figure 39: Communication Platform Wizard: ISP Account Parameters 

2. In the Phone Number field, type the number you use to connect to your ISP. 

3. In the Username field, type the username you use to access your ISP account. 

4. In the Password field, type the password you use to access your ISP account.  

5. Click Next.  
The Finish/View Settings area appears (Figure 42). 

6. Continue with Viewing and Completing Communication Platform Configuration. 

iChipConfig Utility will also send the iChip additional parameters that set the 
authentication method and appropriate values for modem type and modem 
initialization string for dialup analog or GSM modem. 
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4.2.3 Configuring GPRS Parameters 
This procedure describes how to configure GPRS communication platform 
parameters, using the Communication Platform Wizard. 

 What you need:  
 Completion of Starting the Communication Platform Wizard, with the GPRS 

parameter selected. 

 How:  
1. After you click Next in the first Communication Platform Wizard window, the ISP 

Account Parameters area for GPRS appears (Figure 40). 

 

Figure 40: Communication Platform Wizard: GPRS Parameters 

2. In the Phone Number field, type the number you use to connect to your ISP. 

3. In the Username field, type the username you use to access your ISP account. 

4. In the Password field, type the password you use to access your ISP account.  

5. In the Modem init string field, type the initialization string for your modem. 

6. Click Next.  
The Finish/View Settings area appears (Figure 42). 

7. Continue with Viewing and Completing Communication Platform Configuration. 

4.2.4 Configuring LAN Settings 
This procedure describes how to configure LAN communication platform 
parameters, using the Communication Platform Wizard.  

 What you need:  
 Completion of Starting the Communication Platform Wizard, with the LAN 

parameter selected. 
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 How:  
1. After you click Next in the first Communication Platform Wizard window, the 

LAN Parameters area appears (Figure 41). 

 

Figure 41: Communication Platform Wizard: LAN Parameters 

2. To work with a DCHP server, select Yes. 

3. To assign custom values to the iChip, do the following  

a. Select No. 

b. Type the desired values in the IP Address, Subnet, Gateway, and 
Domain Name Server fields. 

4. Click Next.  
The Finish/View Settings area appears (Figure 42). 

5. Continue with Viewing and Completing Communication Platform Configuration. 

4.2.5 Viewing and Completing Communication Platform 
Configuration 
This procedure describes how to view the communication platform configuration 
defined in the Communication Platform Wizard, and how to complete the platform 
configuration and close the wizard. 

 How:  
1. After you click Next in the platform parameters window of the wizard, the 

Finish/View Settings area appears (Figure 42). 
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Figure 42: Communication Platform Wizard: Finish/View Settings 

2. To view the settings defined in the wizard, click View Settings.  

The General Viewer window appears, displaying communication platform settings 
information (Figure 43). 

 

Figure 43: General Viewer Window 
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3. To save the settings and exit the wizard, click Finish.  

The settings are saved, and the Communication Platform Wizard closes. 

4.3 SerialNET Configuration Wizard 
The SerialNET Configuration Wizard enables you to establish connection between 
your device and a remote server, without doing extensive research or needing to 
understand every SerialNET parameter. 

Once the connection is enabled, fine-tuning of the SerialNET setting is required for 
best performance. 

4.3.1 Starting the SerialNET Configuration Wizard 
This procedure describes how to access the SerialNET Configuration Wizard, and 
begin defining SerialNET parameters.  

 How:  
 From the iChipConfig main menu bar, select Wizards > SerialNET Wizard.  

The SerialNET Configuration Wizard window appears (Figure 44). 

 

Figure 45: SerialNET Getting Started Wizard 

4.3.2 Configuring Connection Initiation 
This procedure describes how to configure connection initiation parameters, which 
are different depending on whether your device initiates the connection or is polled 
from the remote location to create a connection. 

 

These setting apply ONLY to the FIRST connection. After a connection is 
established, both the device and the remote server have full duplex TCP 
connection available until one of the devices is disconnected or ends the 
session. 

 How:  
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1. In the First Connection area, do one of the following:  

 If your device transmits data without a specific request: 

a. Select Yes. 

The Remote Side Parameters area appears (Figure 46). 

 

Figure 46: SerialNET Getting Started Wizard: Remote Parameters 

b. In the Remote Side IP Address field, type the IP address of the remote 
server for iChip to contact. 

c. In the Remote Side Port Number field, type the port number on the 
remote server for iChip to contact.  

 If your device waits for a remote request to connect: 

a. Select No. 

The Local Side Parameters area appears (Figure 47).  
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Figure 47: SerialNET Getting Started Wizard: Local Side Parameters 

b. In the Listening Port Number field, type the number of the port on 
which iChip listens for a remote connection request. 

You can use any number between 1 and 65535. However, it is 
recommended that you choose a number higher then 1024. 

2. Click Next.  
The Flush Conditions area appears (see section  4.3.3, Setting Flush Conditions), 
and your device is configured to either initiate a TCP session or wait for one (as 
applicable).  

 

You can also configure the iChip with both parameters using the Full 

Configuration tool (see section  3.3.10) or using AT+i commands (see the 
AT+i Programmer’s Manual). 

4.3.3 Setting Flush Conditions 
This procedure describes how to set the flush conditions for working in SerialNET 
mode. 

By default, every packet that comes from the Internet is immediately stripped of 
TCP or UDP headers, and the raw ASCII data is forwarded to the device. 

However, every character that iChip receives from the device side is buffered, until 
a flush condition is achieved. Then, the buffered content is sent as a TCP or UDP 
packet to the remote side. 

The flush conditions iChip supports include the following parameters: 

 Content – Applicable if your device terminates each transmission with a fixed 
character. IChip scans the character stream until the specified character is 
detected, and then sends the buffered content (including the termination character) 
as a packet. 
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 Quantity – If your device has a fixed number of bytes per transmission, iChip 
counts the specified amount of bytes in the stream. When the buffer reaches this 
exact number of bytes, the buffered content is sent as a packet. 

 Timeout – iChip waits the defined time interval (in milliseconds), then sends the 
buffered content as a packet. 

 How:  
1. After you complete the connection initiation configuration (Section  4.3.2) and 

click Next, the Flush Condition Parameters area appears (Figure 48). 

 

Figure 48: SerialNET Getting Started Wizard: Flush Condition Parameters 

2. In the Transmission Termination area, do one of the following: 

 If you do not use a termination character in your transmissions, select No. 

 If you use a fixed termination char, select Yes, and then type the ASCII value 
character in the indicated field. 

 

If you chose No, iChip is configured with a default timeout interval of 100 
milliseconds. 

3. In the Fixed Bytes per Transmission area, do one of the following: 

 If you do not fix the number of bytes per transmission, select No. 

 If you use a fixed number of bytes for every transmission, select Yes, and then 
type the number of bytes in the indicated field. 

 

To configure multiple parameters for flush conditions, use the Full 

Configuration tool (Section  3.3). 
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4.3.4 Configuring the Host Interface 
When iChip is in SerialNET it cannot determine the local serial port automatically, 
since the Network may be the originating side. Therefore, you need to specify the 
Host interface to be used. 

 How:  
 4.3.3 After you complete the flush conditions configuration (Section ) and click 

Next, the Host Interface dialog appears (Figure 59). 

 

 

Figure 49: Host Interface 

From the Dropdown list, select the Host interface that will be used as the local 
serial port the SerialNET mode. 

4.3.5 Configuring Serial Settings 
This procedure describes how to configure the serial settings parameters for 
working in SerialNET mode. 

 How:  
 4.3.3 After you complete the Host Interface configuration (Section ) and click Next, 

the Serial Settings area appears (Figure 50). 
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Figure 50: SerialNET Getting Started Wizard: Serial Settings 

In this screen you can enter the baud rate, number of data bits, type of parity, 
number of stop bits and flow control type. 

4.3.6 IP Registration 
iChip might be connected to a device that is assigned a dynamic IP address. To help 
the remote server know which devices are online and the IP address of each device. 
iChip can publish its unique host name, currently assigned IP address, and port 
through email or socket registration. 

After you finish setting the serial parameters (as described in section  4.3.4) and click 
Next, the IP Registration window of the SerialNET Wizard appears (Figure 51). 
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Figure 51: SerialNET Getting Started Wizard: IP Registration 

1. If you want to publish your IP address to the remote server or to a 3rd party, 
select Yes. The following options appear (Figure 52): 

 

Figure 52: SerialNET Getting Started Wizard: IP Registration Options 

2. Select either Via Email or Via Socket. 
3. If you select Via Email, the Email Registration Parameters window appears 

(Figure 53). 

4. Complete fields. 



Connect One iChip Config Utility User Manual 

 

      Page 65 of 70 
 

 

Figure 53: SerialNET Getting Started Wizard: IP Registration by Email 

5. If you select Via Socket, the Socket Registration Parameters window 
appears (Figure 54): 

 

Figure 54: SerialNET Getting Started Wizard: IP Registration via Socket 

6. Complete fields. 

7. Click Next. 
The Finish/View Settings area appears (Figure 55). 

8. Continue with Viewing and Completing SerialNET Configuration. 
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4.3.7 Viewing and Completing SerialNET Configuration 
After the SerialNET parameters are defined, you can instruct iChip to go into 
SerialNET mode either immediately or at a later time. 

You can also instruct iChip to always remain online. This is especially useful with 
GPRS communication, which may intermittently disconnect. 

 How:  
1. After you click Next in the registration window of the wizard, the Finish/View 

Settings area appears (Figure 55) 

 

Figure 55: SerialNET Getting Started Wizard: Completing Configuration 

2. To view the settings defined in the wizard, click View Settings.  

The General Viewer window appears, displaying communication platform settings 
information 

3. To save the settings and exit the wizard, click Finish.  

The settings are saved, and the SerialNET Wizard closes. 
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6 Working with iChip Config over a USB 
Connection 
You can work with the iChip CO2128SEC/CO2064SEC using the iChip Config 
Utility over a USB connection. To enable this feature, you need to install a USB 
driver, supplied by Connect One, on a PC running Windows XP OS. 

This driver installs a USB device that appears as a modem to the Windows XP 
operating system. Although the device is connected via a USB interface, it appears 
as if connected via a virtual COM interface, and a new COM port number is 
assigned to this connection. 

The USB driver is supplied as two separate files: sabalo.inf and usbser.sys. 

To install the USB driver: 
1. Copy sabalo.inf to C:\WINDOWS\inf. To view the \inf directory, you must allow 

viewing of hidden folders in Folder Options. 

2. Copy usbser4.sys to C:\WINDOWS\system32\drivers. 

3. Connect one end of a USB cable to your PC. Connect the other end to the USB 
connector of the board on which the iChip CO2128SEC/CO2064SEC is 
mounted. For example, to Connect One’s II-EVB-600 evaluation board. 

4. Switch on the power to the board. 

5. The Found New Hardware Wizard of Windows XP pops up and prompts you to 
install a new device driver. When prompted with the message “Can Windows 
connect to Windows Update to search for software?”, select No, not this time. 

6. When prompted with the message “What do you want the wizard to do?”, select 
Install the software automatically (Recommended). 

7. When a pop-up window reports that the software for the new hardware — 
Connect One Saballo USB Device — has not passed Windows Logo testing, 
select Continue Anyway. 

The USB driver is now installed and ready for use. 

To view the properties of the new driver: 
1. From the Windows task, click Start > Settings > Control Panel. 
2. Double-click the System icon. 

3. In the dialog box displayed, select the Hardware tab. 

4. Click the Device Manager button. 

5. Open the Modems list to find the Connect One Saballo USB Device. 
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7 Glossary 
 

Term Definition 

APN Access Point Name 

ASCII American Standard Code for Information Interchange 

CDPD Cellular Digital Packet Data 

CHAP Challenge-Handshake Authentication Protocol 

CTS Clear to Send. Indicates modem is ready to send information. 

DHCP Dynamic Host Configuration Protocol 

DNS Domain Name Server 

DSR Data Set Ready: Indicates the modem is ready to use 

DTR Data Terminal Ready. Computer issues DTR to the attached modem to 
indicate it is ready to receive data. 

FTP File Transfer Protocol 

FW Firmware 

GPRS General Packet Radio Service 

GSM Global System for Mobile communications 

GUI Graphical User Interface 

HTML Hypertext Markup Language 

HTTP Hypertext Transfer Protocol 

IMF Image File (extension) 

IP Internet Protocol 

ISP Internet Service Provider 

LAN Local Area Network 

MTU Maximum Transfer Unit 

NAT Network Address Translator 

PAP Password Authentication Protocol 

PING Packet Internet Groper 

POP3 Post Office Protocol 3 

PSK Phase Shift Keying 

RAS Remote Access Service 

RS232 Interface for single-ended serial communications (as in between a 
computer input/output port and a peripheral device) 

RTS Request to Send. This command puts the modem in originate mode so 
it can start transmitting. 

SMTP Simple Mail Transfer Protocol 
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SSL Secure Socket Layer. Protocol that manages the security of message 
transmissions in a network. 

TCP Transmission Control Protocol 

UDP User Datagram Protocol 

URL Uniform Resource Locator 

WEP Wired Equivalent Privacy. A security protocol that uses a series of keys 
on both sides of a wireless transmission to encrypt data for secure 
transmission. 

WPA WiFi Protected Access 
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